
 

14 Error and Advisory Messages

 

The CableEye software produces error and advisory messages in response to error con-
ditions, to confirm an operation, or to advise you of a task's completion. Use this alpha-
betical list when you need further information about a message, or are looking for relat-
ed messages that might provide an explanation of some problem. Then, if necessary,
refer to the index to access a more detailed explanation elsewhere in this manual.

 

<cable name> already exits in the cables database. If you continue, you will over-
write the existing match data. Do you want to continue? [Yes|No]

 

File Save Warning
You are about to overwrite an existing file with a new one using SAVE Test Data.

<filename> could not be found.
Missing File
A Notes file (.NTE) or Map file (.MAP) is missing from the Notes Folder or Maps
folder. Note and Map files must be in their respective folders in the CableEye folder
to be recognized.

<filename> could not be found. Defaulting to CableEye.map.
Missing File
A custom Map file (.MAP) is missing from the Maps folder. Map files must be in
their respective folders in the CableEye folder to be recognized. Rather than failing
to operate, the software defaults to the CB board Map file and changes your prefer-
ences from Custom to CB Boards.

<filename> is not a pinmap file.
Missing File
You used a file having extension .MAP as a Map file but it does not have the internal
format of a CableEye map.

<filename> is not a pinmap file. Defaulting to CableEye.map.
Missing File
You used a file having extension .MAP as a Map file but it does not have the internal
format of a CableEye map. The software defaults to the CB board Map file and
changes your preferences from Custom to CB Boards.
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At end of macro [Stop|Restart]
Macro Execution
Execution of a Macro reached a Stop or End instruction and halted automatically.

BANK ERROR: If acquiring 192 or more testpoints, please ensure that all M2 units
are set to 64 or 128 testpoints.

General Operation
When an expansion module is connected, the total number of test points must be a
multiple of 64. You may have the Active Test Points switch on the base unit set to
152, in which case you should change it to 128. This message might also arise as a
result of a hardware failure; if you suspect this, run Self-Test with the active test
point switch set to 128 for M2 and all expansion modules, or 192 for XP1.

CableEye cannot be started without an active test fixture. Ensure your CableEye test
fixture is powered on and correctly attached to your computer, then restart CableEye.

Startup
This message appears when no fixture is detected and you press Cancel to stop
retrying the connection.

C-Matrix is Assymetrical
Data Acquisition
A measured cable has one or more conductors that appear to conduct current in one
direction but not in the other. Two situations may cause this problem. First, a diode
or other semiconductor device will cause one-way current flow and cause this mes-
sage to appear. Second, a very long cable or a cable with capacitors or inductors pre-
sent may distort the signal causing a problem. For long cables, try increasing the
dwell time.

CABLEEYE FIXTURE NOT RESPONDING. Check power and connections. Press
RETRY to try again. Press CANCEL to exit . . .[Retry|Cancel]

Serial Communications
The software cannot establish communications with the test fixture on power-up.
The fixture’s power may be off, the serial cable disconnected, or the serial port inop-
erative or mis-selected, or the fixture has malfunctioned. CableEye’s software will
not operate unless a valid test fixture is detected on the serial port. If the fixture had
been operating correctly and, with no change in computer or setup, now fails to
operate, a hardware failure should be suspected.
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Can’t compare cables: Connector types are different.
Data Logging
Wiring cannot be compared unless the connector types are the same.

Can’t compare cables: Test data not properly acquired.
Data Logging
Test data must be present before it can be compared to Match Data.

Can’t delete records from CAMI cables database.
General Operation
The CAMI cables database is write-protected. If you do not want the CAMI files to
appear in your file list, remove the file CABLESnn.DAT from your CableEye folder.
Or, to make these read/write files, use the Exporter software (Item 709) to join your
CUSTOM.DAT and CABLESnn.DAT files into a new database. Then, when joined,
remove both source files from the CableEye folder and rename the new file CUS-
TOM.DAT.

Can’t find cable <cable name>.
Macro Execution
You attempted to load a cable file that does not exist.

Can’t open the pinmap file for this cable. Make sure your pinmap files are in the
proper directory.

General Operation
The Map file you selected is missing. All .MAP files should be placed in the MAPS
folder within your CableEye folder, except for CABLEEYE.MAP, which should be at
the same folder level as the WinCI executable.

Can’t print cable comparison.
Printing
Printing wiring differences list failed due to an internal error.

Cannot print log file. No log file is open.
Macro Execution
You must open a log file before printing it within a Macro.

CB5 SETUP ERROR Set the active test points to 152 before using CB5.
General Operation
The Active Test Points switch on your M2 module is set to 64 or 128. Change it to
152 and disconnect or switch off all expansion modules.
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CONNECTION ERROR. CableEye cannot identify the CB board or connectors in
use. For further explanation and corrective action, use the Help menu and search for
Connection Error.

General Operation
This message appears in response to various error conditions. You will see this mes-
sage when CableEye’s connector selection logic cannot locate connector graphics for
the wiring it measures. These are the possible causes (given in order of likelihood):

1 - you have attached both ends of a cable to the same CB board. Only one Left con-
nector and one Right connector should be used at any time.

2 - the CB board’s jumper block is missing. Each CB board has a jumper block, gen-
erally located in the top middle of the board. Should this become inadvertently
detached, the software will be unable to identify the board in use, and then cannot
determine the proper connector graphic. If you find the jumper missing and do not
have a replacement, just wire-wrap a wire across the two terminals.

3 - (this does not apply to the M2 System) you have connected a CB board to Bank 1
(the left-most 64-pin latch header on the Expansion Module) at the same time that
one of the two CB boards in use requires an Expander Cable to be attached to Bank
1. The CB boards that need an Expander Cable are CB5, CB7, CB10, and CB12. When
you use at least one of these boards, you must connect the QuickMount housing to
Banks 2 and 3, and the 64-pin end of the Expander Cable to Bank 1. Even if only one
of the CB boards requires an Expander Cable, you must use Banks 2 and 3.

4 - the Test Point switch is set to fewer test points than you are actually using. If you
have boards connected to Banks 1 and 2, the switch must be set for at least 128 test
points. If you have boards connected to Banks 2 and 3, the switch must be set for 192
test points (for the XP1 system).

5 - (this does not apply to the M2 System) you are connecting a cable between one of
the built-in connectors on the main unit to a CB board on the QuickMount housing.
This is permitted, but you must follow these rules: use the built-in connector (such
as DB25 or DB9) for the LEFT side of the cable (connect to the L group), and the CB
board for the RIGHT side of the cable. Also, the CB board MUST be plugged into
Bank 2 or 3; because the built-in connectors share Bank 1, the CB board cannot be
attached there.

6 - a loose wire clipping has fallen onto a CB board, causing a hidden short circuit
between two connectors, or between two pins of a connector that you are not using.
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7 - if you created a custom pin map using the optional PinMap software, you may
not have set the Connectors preference to use the custom Map file you’ve created.
First, be sure this Map file (ends in .MAP) is in your CableEye directory, or your
MAPS subdirectory if you have created one. Then, from the Connectors menu,
choose Custom Pinmap and select your Map file. Once chosen, it should appear in
RED in the system status window or Test Data summary box. Note that when you
save Test Data in the database with a custom Map file selected, the name of that
map file is stored also. Then, when you use Load Cable later to reload that file, its
associated Map file is automatically reloaded too so that new Test Data will be read
using the proper Map file.

8 - if you’ve defined a custom Map file with the PinMap software, your Map file
may be incorrect. If CableEye reads wiring present on test points for which there is
no pin assignment, the software responds with the Connection Error message. First,
double-check your pin map to be sure it has been entered correctly. If there are no
entry errors, change your Connectors preference to generic headers to see exactly
what wiring the tester is measuring, and then confirm that the actual test point
assignments agree with your pin map.

9 - your Connectors choice is set for CB Boards when it should be set for Generic
Headers. If you are using a custom test fixture connected to the 64-pin latch headers
along the front of the unit, or have a non-CAMI connector board inserted, the soft-
ware cannot match the measured wiring to a connector graphic (it does not know
the test-point-to-connector pin mapping). You either must define a custom Map file
with PinMap, or bypass the connector selection logic.

To bypass the connector selection logic, set your connector preferences to Generic
Headers. With this setting, your wiring will be displayed exactly as it is measured
with respect to the absolute test points along the front of the tester. This setting often
helps in determining exactly where a problem exists. When you use Generic
Headers, the setting of the Test Point switch determines whether 32-, 64-, or 96-pin
headers are shown on the graphic display.

10 - your test fixture hardware is malfunctioning. If an integrated circuit within the
test fixture fails, the hardware response will be incorrect and you may get the mes-
sage C-Matrix is Asymmetrical or Connection Error. In either case, detach all boards
from the test fixture and run the Self-Test function in the File menu to confirm prop-
er hardware operation.
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Connections have been eliminated due to connector change.
Netlist Editing
You changed connectors on an existing cable using one or more new connectors
with fewer pins than the original connector. Wiring going to now-nonexistent pins
was deleted.

Connector Types Different. Connectors must be the same when comparing wiring.
General Operation
Wiring cannot be compared unless the connector types are the same.

Continuous test did not complete.
Macro Execution
Continuous Test was manually stopped during a Macro without first stopping the
Macro.

Erase <cable name> now? [Yes|No].
General Operation
Confirmation before a cable is deleted from the database.

Error - No Log File Open.
Data Logging
Attempt to write to a log file that is not open.

Error accessing log file.
Data Logging
An error occurred while opening or reading the log file.

Error allocating netlist.
Internal Error
Internal error. Try exiting and restarting the CableEye application software. Contact
CAMI Research if this is not corrected by a restart.

Error communicating with CableEye test fixture: All serial ports are in use.
Serial Communications
The serial port previously assigned to CableEye is in use by another device, or you
have started a second copy of the CableEye software while a previous copy is
actively linked to the same serial port.
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Error communicating with CableEye test fixture: No response received from test fix-
ture.

Serial Communications
A previously connected test fixture is now not responding. Either the power was
turned off or the serial cable disconnected while the software was operating.

Error communicating with CableEye test fixture: Not a CableEye test fixture.
Serial Communications
On startup, the software received a response from the serial port that was not char-
acteristic of the CableEye test fixture. If you are sure the connections and serial port
selection are correct and the fixture had been operating correctly, there may be a
hardware failure in the test fixture electronics.

Error initializing report printer: <error code>.
Printing
Your selected printer is not responding or is responding incorrectly. Recheck your
selection in File/Report Printer Setup, or change to a different printer.

Error obtaining device defaults: <error code>.
Printing
The default printer selected in the File/Report (or Label or Log) Printer setup menu
cannot be found. Be sure the driver for your chosen printer is installed properly.

Error occurred during search.
Macro Execution
Internal error. Try exiting and restarting the CableEye application software. Contact
CAMI Research if this is not corrected by a restart.

Error occurred in Macro <error status>.
Macro Execution
You attempted to perform an incorrect or illogical operation within a Macro, such as
loading a cable file that does not exist.

Error opening connect.dat.
Missing File
An important resource file, CONNECT.DAT, is corrupted or missing from the
CableEye folder. Replace the file or reinstall the software to restore proper opera-
tion.
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Error opening log file.
Data Logging
Either the extension is incorrect or the data is not in the proper format for a .LOG
file.

Error opening log printer.
Macro Execution
The printer you selected in File/Log Printer Setup could not be found.

Error opening macro file <macro name> <error status>.
Macro Execution
The .MAC file you attempted to open is not a CableEye Macro.

Error reselecting connectors: <error status>.
Netlist Editing
You specified a connector that is not allowed or has pin numbers of a different type
(such as alphabetic instead of numeric).

Error running continuous test.
Macro Execution
An assymetric c-matrix or other internal error was detected while running
Continuous Test.

Error scanning for log file: <error status>.
Data Logging
Log file missing.

Error while printing label: <error status>.
Printing
Your label printer is not On-Line or is reporting a problem (such as Paper Empty).

Error while printing report.
Printing
Your report printer is not On-Line or is reporting a problem (such as Paper Empty).

Error writing file <error status>.
Macro Editing
A disk error occurred, or the file written to has been closed.
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Error writing log header.
Data Logging
Writing the log header failed because a log file is not open.

Error writing summary to log.
Data Logging
Writing the log summary failed because a log file is not open.

Error writing test result to log.
Data Logging
Writing the log result failed because a log file is not open.

Failed to allocate printer object.
Printing
Internal error. Try exiting and restarting the computer and printer. Contact CAMI
Research if this is not corrected by a restart.

Fatal error while executing self test.
Internal Error
You disconnected the test fixture from the serial cable while Self-Test was operating.
Reattach the cable, exit back to the desktop, and restart the CableEye software.

File does not exist.
General Operation
The software attempted to open a .MAP or .LOG file that cannot be found.

Filename must not be longer than 20 characters.
General Operation
You are limited to 20 characters for a cable name.

Illegal Combination of Connectors. Please retest and select connectors to which the
cable is attached.

General Operation
You chose a combination of connectors that is logically not possible given the mea-
sured wiring. Remeasure the cable, and when the Connector Selection window
reappears, choose the correct combination of connectors.
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Illegal count specified.
Macro Execution
You specified a count value using the SET INITIAL COUNT . . . or ENTER INITIAL
COUNT . . . that is not allowed. All count values must be integers between 0 and
9999.

Illegal Loop Count.
Macro Execution
You specified a count value using the SET INITIAL COUNT . . . or ENTER INITIAL
COUNT . . .  that is not allowed. All Count values must be integers between 0 and
9999.

Illegal Test Data Read. Check attachment of fixture, test point switch, and port
assignment.

Serial Communications
Improperly formatted data was returned from the test fixture port. The test fixture
or serial port may be malfunctioning, the test fixture may have been disrupted by
static electricity, or you may have a non-CAMI device connected where the test fix-
ture is expected. If you are sure the connections and port selection are correct, try
running the Self-Test function in the File menu to check the fixture electronics.

Internal error constructing connection array.
Internal Error
Internal error. Try exiting and restarting the CableEye application software. Contact
CAMI Research if this is not corrected by a restart.

Label text would overflow the currently selected label stock. Continue printing any-
way? [Yes|No]

Printing
You have entered too much label text for the size of label currently selected.

Log closed.
Data Logging
(advisory message only)
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Macro error. You used an IF statement without first using COMPARE TEST TO
MATCH.

Macro Execution
You must use COMPARE TEST TO MATCH before using IF MATCH THEN . . . or
IF NOMATCH THEN . . . so that the condition flag representing Equality between
Test and Match data is valid.

Macro Error: Please load Match Data before using LOG HEADER. A cable name for
Match Data must appear in the log’s title block.

Data Logging
The log file’s header is extracted from the Match data, so you must first load Match
data before recording a header in the log file.

Macro file name must have extension .MAC
Macro Editing
You attempted to use an extension other than .MAC for a Macro.

Macro has changed. Discard changes? [Yes|No]
Macro Editing
You pressed Cancel after you made editing changes to a Macro.

MAP ERROR Active test points greater than map test points.
General Operation
The MAP file that is currently active has pin assignments for fewer test points than
have been measured. You need to change the ACTIVE TEST POINTS switch, or dis-
connect an expansion module from the system.

MAP ERROR Active test points less than map test points.
General Operation
The MAP file that is currently active has pin assignments for more test points than
have been measured. You need to change the ACTIVE TEST POINTS switch, or add
an expansion module to the system.

Match data not loaded.
Macro Execution
You need to have valid Match Data before using COMPARE TEST TO MATCH.
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Memory allocation failure.
Printing
Internal error. Try exiting and restarting the computer and printer. Contact CAMI
Research if this is not corrected by a restart.

NO CABLE CONNECTED Attach cable to test fixture and try again.
General Operation
No wiring was detected after you executed TEST CABLE or LEARN CABLE. 

No comparison done.
Macro Execution
(advisory message only)

No connect.dat file found.
Missing File
An important resource file, CONNECT.DAT, is missing from the CableEye folder.
Replace the file, or reinstall the software, to restore proper operation.

No Macro instructions entered. Please choose one or more instructions before saving.
Macro Editing
You attempted to save a Macro that had no instructions.

No match found.
General Operation
This occurs in response to Search Database. No cable in the database matches the
wiring and connectors of the cable you searched for.

Not Enough Memory for Operation. Insufficient dynamic memory is available to
execute this function.

Internal Error
Internal error. Try exiting and restarting the CableEye application software. Contact
CAMI Research if this is not corrected by a restart.

Okay to overwrite <macro name>? [Yes|No]
Macro Editing
You are attempting to save a Macro using a name that already exists. Continuing
will erase the existing Macro and replace it with the one you are about to save.
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Please enter a Macro name before saving.
Macro Editing
You attempted to save a Macro that had no name.

Please Save or Cancel netlist changes before changing connectors.
Netlist Editing
You may change connectors only when the pin editing mode is inactive.

Printer not responding. Make sure printer is connected and on-line.
Printing
The printer you selected in File/Report Printer Setup could not be found.

Revert to default printer and retry?
Printing
The alternate printer you selected is not responding.

SEARCH FAILED No test data loaded.
Macro Execution
You need to have valid Test Data before using SEARCH DISK FOR MATCH

Summary added and Log closed.
Data Logging
(advisory message only)

Test and match data are not loaded.
Macro Execution
Test and Match Data must be present before you can print a Differences List.

Test data not loaded.
Macro Execution
Test data must be present before it can be printed.

There are unsaved modifications to your macro. Exit anyway? [Yes|No]
Macro Editing
This confirmation message appears when you click Cancel from a Macro editing ses-
sion.
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This is a CAMI cable and cannot be modified or saved. Please select another name
with which to save this cable data.

General Operation
You attempted to update a file taken from the CAMI database (it has a CAMI ID
associated with it). These cables are read-only.

Timeout Reading Test Data. Please check port assignment and test fixture.
Serial Communications
A previously connected test fixture is now not responding. Either the power was
turned off or the serial cable disconnected while the software was operating.

Too many active testpoints for header display. To display wiring select the WIRING
HARNESS option in PREFERENCES.

General Operation
You have set the Connectors menu for GENERIC HEADERS but have more than 192
test points active. GENERIC HEADER shows dual-row headers of up to 96 pins on
each side of the screen. If more than 192 test points are active, you must change the
setting to WIRING HARNESS.

Write Access is not allowed. The Write Enable file contents are incorrect.
Write Protection
An attempt was made to write to a write-protected file. If the write protection soft-
ware has disabled all relevant functions, you should never see this response. If you
do, please contact CAMI Research and let us know the circumstances. 

Write Access is not allowed. The Write Enable file is not present.
Write Protection
An attempt was made to write to a write-protected file. If the write protection soft-
ware has disabled all relevant functions, you should never see this response. If you
do, please contact CAMI Research and let us know the circumstances. 

Your database files CABLESnn.DAT and CUSTOM.DAT are missing. Please place
these files in your CableEye folder before using Load Cable or Search Database.

Cable Database
At least one database file must be present for SAVE, LOAD CABLE or SEARCH
DATABASE to operate.
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Your MATCH DATA contains modifications to <modified data items> [Save|Don’t
Save|Cancel]

File Save Warning
You are about to update an existing file using SAVE Match Data.

Your TEST DATA contains modifications to <modified data items> [Save|Don’t
Save|Cancel]

File Save Warning
Warning message before exiting the program or measuring a new cable.
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